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The intent of this page is to provide information specific to the 5.x versions of ECCE. Version 5.0 completes the migration of all ECCE applications to the cross platform open source user interface toolkit, wxWidgets.  Specifically the user interface for the Calculation Viewer has been completely redesigned and integrated with the Builder to create a single combined visualization capability.  Version 5.0.1 primarily adds a small number of new Builder/Viewer features.  Version 5.0.1 notes have titles highlighted in green text.

Release notes dating back to ECCE 4.5 are also included here as several of those release notes are pertinent to the new integrated Builder/Viewer application.  Version 4.5 featured a completely redesigned Molecule Builder user interface, cross platform toolkit ports of three more major ECCE applications, additional molecular dynamics capability, NWFS archive support for EMSL users, and a new messaging server implementation.  Version 4.5.1 bundled the new NWChem 5.1 release and added some Builder and Calculation Viewer enhancements.
RELEASE NOTES FOR PREVIOUS VERSIONS
Version 4.x Release Notes – December 27, 2007
Version 3.2.x Release Notes – April 5, 2006
WHAT’S NEW

Gaussian Cube File Visualization
(5.0.1)  Restoring a pre-ECCE 5.0 feature for visualizing Gaussian Cube format files, the 5.0.1 Viewer handles both cube files that are part of the output from a calculation run from within ECCE and standalone cube files.  Any cube files produced by an ECCE run calculation can be displayed using the new “Cube File” property panel in the Viewer similar to other properties for the calculation.  To display a standalone cube file that is on the local machine where the Viewer is being run, use the “Open in new context…” menu item under the File menu after opening the Viewer from either the Gateway toolbar or the command line with the “ebuilder” command.  Alternatively, the name of the cube file can be passed as a command line argument to the “ebuilder” command (the “ebuilder” command is used to bring up the integrated Builder/Viewer application whether it is to be used for building molecules or viewing calculated properties).  Select the surface to display from the list on the left side of the “Cube File” property panel.  Note that the property panel allows linear combinations of two different surfaces to be calculated and displayed by left mouse button clicking on the name of the first surface, right mouse button clicking on the name of the second surface, and then entering the coefficients for the linear combination into the “A” and “B” numeric entry fields on the property panel.

MO Panel Energy Graph
(5.0.1)  Another pre-ECCE 5.0 feature, this time for displaying molecular orbital occupation energies graphically, has been restored.  From the Viewer “MOs” property panel select “Graph” or “Graph by Symmetries” from the dropdown option menu near the right hand side of the panel title bar.  The color of each orbital on the graph denotes its occupation number as indicated by the graph legend.  Note that the orbital occupation energies graphed are integrated with the MO visualization by left mouse button selecting an orbital from within the graph and hitting the “Compute” button below the graph.

Builder Atom Dragging
(5.0.1)  Atoms and groups of atoms selected in the Builder can be moved (translated) in space by dragging (left mouse button selection and holding down the mouse button during the operation) over any one of the selected atoms in space.  This is a quick and imprecise, although often very useful, alternative to using the other Builder manipulator tools or entering atom coordinates directly in the Atom Table.  Note that any atom translations made in this way can be undone with the undo (ctrl-z) capability from the Edit menu.

Exporting Tabular Data
(5.0.1)  Data in the Builder and Calculation Viewer can be exported to a comma-separated values (CSV) file using the right mouse button popup “Export…” menu item.  This includes tabular data such as the atom table, residue table, MOs, vibrational frequencies, moments, etc.  The Organizer also supports exporting calculation summary fields displayed in the right-hand side project context panel to a CSV file.

Adding Ghost Atoms
(5.0.1)  The Builder allows ghost atoms (normally used in the Symmetry panel) to be added arbitrarily as atom placeholders when building a chemical system or for any other desired purpose.  Under the Build panel “More…” button the ghost atom is shown with the symbol “X” in the bottom left corner of the periodic table.  Selecting this “X” element allows any number of ghost atoms to be added to the workspace by clicking in free space as with the other periodic table elements.  The default bonding hybridization for ghosts is a lone atom although this can be changed in the Build panel to allow bonded ghost atoms.

BqX Atom Behavior
(5.0.1)  The Builder Atom Table contains two new dropdown option menu items for setting the behavior to BqX for all currently selected atoms and clearing the behavior field for all atoms, selected or not.  Additionally the different types of atom behavior (Point, Quantum, Bq, BqX) can be entered directly (case insensitive) in the behavior field of the table for an atom.  BqX atoms are typically used in NWChem QM/MM calculations, although ECCE does not currently offer any additional support for this type of calculation.

Authenticating as a Different Data Server User
(5.0.1) The initial ECCE login window now contains a “Data Server Login” field above the password field.  This is used for remapping from a Linux login name (specified by the $USER environment variable) to a different name on the Apache2 DAV server used by ECCE to store calculation data.  The first time a user starts ECCE the “Data Server Login” field will be editable with a default value of the current Linux login name.  This allows the user to change the name of the initial data server account that is created on the ECCE server (assuming automatic data server account creation is enabled).  Note that if a name is specified that is an existing data server account, the user will need to give the proper data server password for that account (in a different password dialog that is displayed after the ECCE login window) in order to access that data.  This allows multiple users to share the same data server account and home directory either temporarily or longer term.  After the initial login to ECCE the “Data Server Login” field will be disabled so a different user name cannot be specified, although the current setting will be displayed.  However, it is still possible to set a different name after the initial login by starting ECCE with the command “ecce –l <DataServerLogin>” with the new login specified after the “-l” command line option (lower case letter “el”, not the number “one”).  Since changing the data server login name is typically seldom needed, disabling the “Data Server Login” field after the initial login was done to keep users from inadvertently changing to a different user resulting in confusion and unintentional creation of new data server accounts.

Closing Remote Shells when Exiting
(5.0.1)  A Gateway Preferences dialog toggle labeled “Close Remote Shells on Exit” has been added.  Toggling the preference “on” will result in all xterm shells (tail –f on output file, shell in calculation run directory) started in the current ECCE session being closed automatically when the Gateway (session) is exited.  The default behavior is still to leave these remote shells up indefinitely even after the ECCE session is gone, allowing users to continue working in them.  A word of caution to those who change the default behavior to close remote shells on exit:  be careful that you aren’t performing tasks in these remote shell windows where you haven’t saved your work when exiting from ECCE, such as editing a file or running a program.  ECCE immediately terminates these remote shells when exiting the Gateway and you may lose work as a result.  A related bug was also found and fixed so the “ecmd” process that ECCE creates for each remote xterm shell is now properly cleaned up from the process table when the user exits the shell or the shell is closed when ECCE exits based on the preference setting.  Previously these ecmd processes lived indefinitely after the shell and even the ECCE session where it had been created no longer existed.

New Calculation Viewer

(5.0)  ECCE 5.0 features a redesigned user interface for the Calculation Viewer.  The Viewer is now integrated into a single application with the Builder, itself redesigned for the previous ECCE 4.5 release.  A single ECCE visualization application is now used for building chemical systems and viewing calculation/task output.   This design ensures that all panels that are applicable to both the Builder and the Viewer, such as the selection panel, are available when needed with reduced maintenance overhead.

The dockable panel user interface paradigm first used for the ECCE 4.5 Builder is now used for the Viewer property panels in addition to the Builder tool panels.  The Viewer main window is divided into property panels along the left hand side (as with the pre-5.0 Calculation Viewer), the visualization/work area in the center, and build tools along the right hand side.  For build tool panels, the panel layout is completely configurable by the user dragging the panels and docking them in different places within the main window or “floating” them outside the main window as their own windows.  These build tool panel locations, including docked or floated, are saved as user preferences and restored with the next invocation.  Viewer property panels are an exception to saving and restoring their layout.  Their location can be changed within an invocation, but will not be saved and restored between invocations.

Although the Builder and Viewer are actually the same executable, ECCE still maintains the distinction between the two in the Gateway toolbar and Organizer—each can be invoked separately.  For a calculation or task that is being setup and run within ECCE, the run state determines whether it is a “Builder” or “Viewer” type invocation.  Any calculation with a run state of Created or Ready will start a “Builder” instance regardless of whether the Builder or Viewer was selected in the Organizer.  Likewise, for a calculation with a run state of Submitted, Running, or one of the completion states, a “Viewer” instance will be started regardless of whether the Builder or Viewer was selected in the Organizer.  The type of instance, Builder or Viewer, simply determines which panels and operations are available to the user (cannot modify a chemical system for a running calculation for example) and whether the window title indicates a Builder or Viewer.
Like the build tool panels, in order to conserve screen space within property panels, option menus are commonly used to access functionality not on the panel itself.  These option menus are displayed by hitting the left mouse button over top of the blue and white window icon near the right hand side of the property panel title bar.  If you can’t find functionality that was in the old Calculation Viewer in a new Viewer property panel, this is the first place to check.

The dockable panel nature of the Builder/Viewer and fussiness of the wxWidgets implementation for this capability sometimes results in undesirable if not bizarre and unusable panel layouts.  In this case the “Reset Defaults Tools/Toolbars” operation in the Options menu can be used to restore sanity.  After answering “Yes” to the confirmation dialog, you must exit and restart the Builder/Viewer to restore the default layout.
The Builder/Viewer is the only ECCE application that supports multiple contexts (calculations, chemical system files, trajectory animations, etc.) at the same time in a single instance of the tool.  This design should be transparent to traditional ECCE users who bring up the Builder/Viewer in the context of an existing calculation to build a chemical system or visualize results and then close the application when done with their immediate task.  But, for those who deviate from this usage, the multiple context design can take a bit of getting used to.  Contexts mimic the design of many other visualization tools.  A “Context” panel, which shows up with the other right-hand build panels, lists the current contexts and enables quick switching between them.  The “File” menu contains three menu items for controlling contexts.  “New context” creates an empty context whose name initially starts with “Unnamed”.  This empty context can be used, for instance, to build chemical systems from scratch or using the “Import chemical system…” menu item.  “Open in new context…” combines the “New context” operation with selecting a file to display in the newly created context.  The selected file can be a chemical system, but this is also the way to open and animate the frames of a trajectory file or sequence of batched trajectory files (by selecting any single file in the sequence).  Finally, “Close context” will close the currently displayed context, prompting to save any work if there are unsaved changes.
The “Save as…” operation in the Builder/Viewer is more powerful than in previous releases of ECCE.  “Save as…” is used for saving chemical system file formats (xyz, pdb, etc.), saving image snapshots of the visualization area (jpeg, POV-Ray, etc.), and for saving out the current context as a brand new electronic structure calculation (NWChem, etc.).  A drop down menu below the file name text entry field is used to specify the type of file to generate.  Saving a chemical system as an electronic structure calculation allows users to start the setup process by building their structure and then defining the chemistry code and where they want to put it on the ECCE data server.  Further, if a geometry trace or trajectory is being visualized, the “Save as…” operation saves the step that is currently being displayed allowing explicit control for creating structures to serve as the starting point for additional work inside or outside ECCE.
As with previous releases, the “ebuilder” script is used to invoke the standalone version of the Builder from the command line.  The “ebuilder” command is also used to open trajectory files (NWChem trj, or generic xyz format) as a “Viewer” instance of the standalone builder.  The chemical system or trajectory file to load can be given as a command line argument to ebuilder.  Alternatively, the “Open in new context…” (chemical systems or trajectories) or “Import chemical system…” (chemical systems only) File menu operations can be used to load a file after invoking “ebuilder” without command line arguments.  Invoking the Builder from the Gateway toolbar is equivalent to an “ebuilder” invocation without any arguments while invoking the Viewer from the Gateway toolbar automatically performs an “Open in new context…” operation from the newly created application—used for opening chemical systems or trajectories.  An enhancement from previous ECCE releases, the “ebuilder” script is now fully functional even in a full ECCE install.  Previously the “Structure Library”, “DNA Builder”, and “Peptide Builder” would not work from “ebuilder” except when a “standalone builder” distribution of ECCE was downloaded and installed.
Unfortunately, for the initial release there exists no additional documentation on using the ECCE 5.0 Builder/Viewer beyond these release notes.  We strived to make it as intuitive and stick with names and conventions established by previous releases of ECCE where feasible.  You are encouraged to play with it to see how it can be applied to your work.  Finally, please don’t hesitate to ask questions or give us feedback by sending email to ecce-support@emsl.pnl.gov.

Old Builder and Viewer No Longer Distributed
(5.0)  The ECCE 5.0 distribution no longer contains the old X Window Motif versions of the Molecule Builder and Calculation Viewer applications.  In the ECCE 4.5.x distributions the old Builder was distributed as a backup to the new wxWidgets version.  This was done in case users found problems with the new Builder significant enough that they needed to revert to the old version to accomplish their work.  Plus, some rarely used components of the old Builder (e.g., the MD Topology Viewer and Force Field Editor) have not been ported to the new wxWidgets version.  Since the initial ECCE 4.5 release, the new Builder, now integrated with the Viewer, has become significantly more robust and reliable and the ECCE team does not anticipate sites needing to use the old versions.  This decreases the size of the distribution and installation, especially with third party libraries for only a single GUI toolkit being distributed instead of two GUI toolkits.  A not unintentional side effect is that if problems are found with either the new Builder or Viewer, feedback to the ECCE team will be needed, which might not be the case if the old versions were easily available.  There are a small number of what the ECCE team considers to be minor features that were not implemented in the new Viewer (conversely, there are a large number of new capabilities not previously available).  If you discover a missing feature from the old Builder or Viewer that you found valuable that you would like to see added back, please contact us.  We are also still able to provide these old Builder and Viewer versions on request.
Normal Modes Property Renamed

(5.0)  For consistency with NWChem and other chemistry codes, the Normal Modes property panel in the Viewer has been renamed to Vibrational Frequencies.  Calculations that were run prior to ECCE 5.0 will automatically display what was Normal Mode data in the Vibrational Frequencies panel.
Open Source GUI Migration

(5.0)  The redesign of the Viewer porting it to the wxWidgets GUI toolkit completes the migration of all ECCE applications to rely on only freely available open source products.  This effort was undertaken in 2005 with one or more applications being ported to wxWidgets (see http://www.wxwidgets.org) with each release starting with 4.0, all while continuing to simultaneously add computational chemistry domain functionality.  Core ECCE applications use the wxWidgets C++ toolkit, while the code registration dialogs are implemented under wxPython, the wxWidgets binding to the Python scripting language.  In addition to being an open source product, wxWidgets is a cross platform toolkit that supports all major operating systems.  Eliminated are two proprietary GUI development tools for the UNIX/Linux only X Window System Motif toolkit, which date back to the first production release of ECCE:  Aonix TeleUSE and Quest XRT PDS widgets.  This milestone opens up several new possibilities for the future of ECCE such as collaborative and contributed code developed outside the ECCE project team (only electronic structure code registration was previously possible) and ports to different operating systems including Microsoft Windows and Macintosh OS X.  While the ECCE project team is not currently scoped for completing the ports to operating systems beyond Linux, please contact us if you are interested in doing ECCE development, including porting to another operating system or adding chemistry domain functionality.  At this time there is no task to make ECCE source code available for download in a useful form; i.e., able to compile in an autoconf type environment (there are numerous third party packages ECCE relies on that make it more complex to build than lower-level software like NWChem).  However, it is feasible that the identification and commitment of an outside group to extend ECCE in a way that benefits a broad base of users could justify this task of creating and documenting a build environment.  Finally, of note to those who would like to run ECCE on Microsoft Windows based systems is a task planned for 2009 to make a distribution of ECCE available that runs under virtualization software such as VMware (see http://www.vmware.com) and/or VirtualBox (see http://www.virtualbox.org).  While not a native operating system port, this will make running ECCE feasible at sites where Linux is not available.  For sites with limited access to Linux systems, the use of X Window Server software that supports OpenGL such as Hummingbird Exceed 3D (see http://connectivity.hummingbird.com/products/nc/exceed) or Cygwin/X (see http://x.cygwin.com) already allow users to run ECCE from a backend Linux workstation displaying on Windows based desktops.
Color Themes

(5.0)  ECCE now allows colors for application windows and GUI controls to be changed at the site level and by each user.  Colors can either be changed individually by type of control or one of a small number of themes can be selected.  The default ECCE colors have been changed in the 5.0 release to conform to the new Pacific Northwest National Laboratory branding although the “Classic” theme can be selected to restore the familiar pre-5.0 look.  Colors are specified in a configuration file in the $ECCE_HOME/siteconfig directory name AppColors.  This file also documents what control type colors can be changed, what the theme names are, how to specify a color value, and how users can create their own MyAppColors file to override the site level colors.  Alternatively, the Gateway toolbar Preferences dialog contains a “Color Theme” choice box that updates the user MyAppColors file, but does not allow control of the individual control colors.  The ECCE login window has also been changed to match the new branding with PNNL and EMSL logos added.  The color of the ECCE wave logo in the background of the login window has also been changed (now PNNL-branded copper) and will not update with changes to the AppColors or MyAppColors files (same for the animated wave logo in the ECCE Gateway toolbar).

Renamed Applications

(5.0)  Several ECCE application names have been shortened or changed for consistency.  The Calculation Viewer is now simply Viewer.  The Job Launcher is now Launcher.  The Calculation Editor is now Electronic Structure Editor in a generic sense or NWChem Editor, etc. when in the context of a chemistry code.  This is more consistent with the variety of new ECCE editor applications for different fields of chemistry—molecular dynamics and upcoming support for thermodynamics.  Finally, the Molecule Builder is simply Builder as most users refer to it already. 
NWChem 5.1 Bundled

(4.5.1)  ECCE binary distributions for both Linux and SGI IRIX now include NWChem 5.1.  Additionally the registration for the EMSL 12-teraflop HP Linux cluster mpp2 has been updated to run NWChem 5.1 for jobs launched from ECCE.  No changes have been made to the NWChem code registration in ECCE specifically for NWChem 5.1 as input and output files are compatible with the previous NWChem 5.0 release.  As with past releases of ECCE that have bundled NWChem, it is recommended that sites wishing to improve the performance of the computational code download and use a distribution of NWChem separate from the one bundled with ECCE.  This allows NWChem to be tailored to the specific hardware platform where the distribution bundled with ECCE is more generic.  For example, the Linux distribution of NWChem bundled with ECCE is a 32-bit executable even for 64-bit platforms and thus will perform poorly on higher performance Linux workstations.  It is a straightforward matter to configure ECCE to run separately installed NWChem distributions using the Machine Registration application.  ECCE bundles NWChem as a matter of convenience for those evaluating either ECCE or NWChem with the intent that users running the software for actual research will install NWChem separately.  For less demanding computational applications on low-end hardware, it may be feasible though to continue using the ECCE bundled NWChem distribution.

Molecule Builder Manipulator Tools

(4.5.1)  The two “manipulator” tools allowing atoms to be dragged in 3-D space and rotating atoms around bonds that were part of the Builder prior to the wxWidgets port, have been added back into the Builder for ECCE 4.5.1.  The ball or sphere manipulator lets you select a group of atoms, add a spherical wireframe around the selection and then drag and rotate the sphere to move the atoms contained inside.  The rotation manipulator lets you freely rotate around a bond (or any two atoms) to move all bonded atoms.  With the ECCE 4.5 release, several users lamented the loss of these tools for quickly adjusting the position of atoms.  In order to use these manipulator tools, you need to first place them on your Builder toolbar, accomplished by selecting “Manipulator Toolbar” from the Tools->Toolbars menu.  ECCE will remember your preference for toolbars between invocations after the first time it is initially added.  Also note that the Coordinate Operations panel newly added with the Builder wxWidgets port allows more precise translations, rotations, and alignments of atoms to be performed.

Customizing Molecular Orbital Color

(4.5.1)  A simple capability has been added to allow any arbitrary color pair for molecular orbitals displayed in the Calculation Viewer.  This feature is useful for tailoring orbitals for publication or presentations when the existing ECCE color choices prove too limited.  To use a custom color pair, one of two different environment variables must be set to specify the desired colors prior to starting the ECCE application software.  Then, once in the Calculation Viewer, the “light/dark” color pair must be selected from under the Surface menu for ECCE to know to apply the custom colors.  Two environment variables are provided in order to allow the colors to be specified in two different ways.  Only one of the two variables needs to be set.  The first variable is named $ECCE_SURFACE_COLOR1 where values for the red-green-blue components are specified between 0.0 and 1.0 as normalized floating point values.  The second variable is named $ECCE_SURFACE_COLOR255 where values for red-green-blue components are given between 0 and 255 as 8-bit or 1-byte values.  Each of these environment variables consists of six different numbers making up the RGB components of the positive and negative orbital lobes.  Each of the six numbers is separated by any of four different tokens:  a space, a comma, a colon, or a forward slash (/).  For instance, if you wanted green and blue as your color pair, from the C shell prompt you could specify “setenv ECCE_SURFACE_COLOR1 0.0,1.0,0.0/0.0,0.0,1.0”.  Alternatively, you could specify “setenv ECCE_SURFACE_COLOR255 0,255,0/0,0,255”.  Make sure if you use spaces as separators between the color components that you quote the entire value of the variable.  You are free to mix the space, comma, colon, and slash separators however you wish, although using the same separator token between red, green, and blue components and then a different one between the positive and negative lobes makes the value more readable.  Finally, a good reference for choosing colors is the X Window System rgb.txt database of colors, found at /usr/X11R6/lib/X11/rgb.txt on most Linux systems.  This file lists the 0 to 255 format RGB components for hundreds of colors along with a name for each color. 
New Molecule Builder

(4.5)  The ECCE team drew on user feedback over many years on what you did and didn’t like about the existing version to drive the design of the new Molecule Builder.  The result is a user interface that makes it easier to find functionality, is more customizable, adds new capabilities, and has a modern toolbar and “dockable panel” layout.  Although the previous Builder offered a lot of flexibility in order to build almost any desired chemical system, it was often hard to know where to find and how to use the functionality required.  The new Builder better adheres to conventions established by other builders and drawing packages to make it easier to find and use functionality, especially for users new to ECCE.  The ECCE development team is confident that after an initial “getting acquainted” period, even long-time ECCE users will find that the new Builder improves their productivity over the previous Builder version.  The new Builder was implemented with the cross platform wxWidgets GUI toolkit continuing the migration of all ECCE applications from proprietary GUI technologies running only on the Linux/UNIX platform to an open source release on all common desktop operating systems.  The new Builder includes web browser based help available by selecting the “on Builder…” menu item from the Help menu.  We especially recommend this introductory level documentation to those users familiar with the previous Builder just starting to use ECCE 4.5.  The new Builder is also available as a standalone distribution separate from the rest of ECCE.

New Calculation Editor

(4.5)  The electronic structure code (NWChem, Gaussian, etc.) Calculation Editor has been ported to the wxWidgets cross platform GUI toolkit and includes a minor user interface redesign.  Only the main window of the Calculation Editor was changed, as the underlying theory and runtype detail dialogs specific to each chemistry code had previously been ported to the wxPython (wxWidgets GUIs scripted in Python) toolkit.  No new documentation has been created for the new Calculation Editor, but usage will be familiar to anyone who has run the old X Window System based Calculation Editor with only a few fields on the main window having been changed.  The biggest difference in the Calculation Editor is the inclusion of two dialogs or toolkits for specifying constraints/restraints and setting up partial charge calculations.  These toolkits were previously part of the Builder application because they rely heavily on selection of the chemical system.  But, the port to wxWidgets provided the opportunity to move these toolkits to a more intuitive spot when setting up code input rather than defining the chemical system.  Access to these toolkits is based on the current run type that is selected in the Calculation Editor.  For run types that find an optimized geometry, the “Constraint Toolkit…” button will be shown next to the “Final Edit…” button near the bottom of the Calculation Editor main window.  The new Constraint Toolkit user interface follows the previous Builder based version.  By choosing the ESP run type for NWChem, the “Partial Charge Toolkit…” button will be shown next to the “Final Edit…” button.  The Partial Charge Toolkit user interface has been changed more significantly than the Constraint Toolkit from the previous version to simplify its usage.  It now maintains a running list of command directives that have been created within the toolkit that will be included in the NWChem input deck.
New Basis Set Tool

(4.5)  The Basis Set Tool was also ported to the wxWidgets cross platform GUI toolkit since the last production 4.0.2 ECCE release.  Again, anyone familiar with the previous X Window System Basis Set Tool should be comfortable using the new wxWidgets version.  The same functionality is available in the new version as the old, although there have been some minor layout changes to the main window.  Access to the Basis Set Tool has been removed from the Gateway application for ECCE 4.5.  This Gateway invocation was provided for using the Basis Set Tool outside the context of an ECCE calculation where the chemical system and code were specified within the Basis Set Tool and the results were exported to a file.  The EMSL Basis Set Exchange web portal, available at http://bse.pnl.gov, is now the preferred means for selecting basis sets for running codes outside ECCE.

Support for Potential of Mean Force (PMF) MD Calculations

(4.5)  The ECCE development team has continued to work on extending its support for different MD calculations by including options for setting up, running, and looking at the results of Potential of Mean Force (PMF) free energy calculations.  This includes an additional tabbed panel in the MD Prepare task editor that allows users to add various PMF directives to the NWChem Prepare module input deck and new tabbed panels in the MD Optimize and MD Dynamics task editors that allow users to include options that control the number of windows, etc. in each calculation.  For examining output from PMF calculations, the new PMF Grapher available from the Calculation Viewer lets the user select the PMF directive of interest and a subset of the PMF frames to graph.  Energy distributions, coordinate distributions, and energy vs. coordinate can be graphed within the same plot or separately.

Enhanced MD Property Graphing

(4.5)  The new MD Property Grapher allows the user to plot a single property against one or more other properties in an XY scatter plot, all of which appear in the same plot.  Two lists of properties are shown in the user interface for the MD Property Grapher, which is invoked from the Calculation Viewer.  One property is selected for the X-axis and one or more properties for the Y-axis before hitting the “Graph” button.  Both the Property Grapher and the previously mentioned PMF Grapher use the Gnuplot package (http://www.gnuplot.info) to produce output graphs, allowing additional capabilites such as interrogating plotted data points for exact values.  Additionally, both the Property and PMF Graphers can be run outside of the Calculation Viewer from the command line using the commands “eprp” and “epmf”, respectively.  The names of the .prp and .pmf type files to graph are passed on the command line to the scripts, usually with a wildcard file specification.  This allows users who prefer to run NWChem MD simulations outside ECCE to use a portion of the ECCE MD analysis capability.
NWFS Archive Support

(4.5)  Users of ECCE within EMSL now have the capability to store the large files produced by molecular dynamics calculations directly to the NWFS archive.  The “Configure NWFS Archive Access…” menu item in the Organizer Edit menu is first used to specify to ECCE how to connect to the archive on behalf of the user (user name, password, and top-level directory).  Then the MD Optimize and MD Dynamics task editors have a new dropdown menu under the Files/Trajectory panel for selecting to store output to the NWFS archive, the ECCE data server, or not to store output other than on the compute resource where it is calculated.  All trajectory, restart, and PMF files produced by the calculation will be stored to the location specified by this menu setting.  The Calculation Viewer transparently accesses this data from the location specified for each calculation (archive, data server, or compute resource) without any extra steps by the user.

SITE ADMINISTRATOR WHAT’S NEW
Upgrades of ECCE Data and Messaging Servers

(5.0) The Apache2 HTTP server (see http://httpd.apache.org) used for the ECCE data server along with the bundled mod_dav module has been upgraded from release 2.0.59 to the latest 2.2.10.  The ActiveMQ Java Messaging Server (see http://activemq.apache.org) used for the ECCE JMS messaging server has also been upgraded from release 4.1.1 to 5.1.0.  When installing, we highly recommend upgrading the ECCE server to 5.0 rather than solely the application software.  In fact, we have experienced messaging session disconnects with accompanying java stack trace output in the window where the ECCE application session was started when running ECCE 5.0 application software against an ECCE 4.5.x server.  These problems can be attributed to incompatibilities between the ActiveMQ 5.1.0 client side java messaging libraries used by ECCE 5.0 and the ActiveMQ 4.1.1 server distributed with ECCE 4.5.x.

Upgrade of wxWidgets GUI Toolkit

(5.0) The wxWidgets C++ GUI toolkit (see http://www.wxwidgets.org) used by ECCE core applications has been upgraded to the latest stable release, 2.8.9.  Likewise, the wxPython toolkit (see http://wxpython.org) used for code registration theory and runtype details dialogs has also been upgraded to use the same distribution of wxWidgets.  For ECCE this wxWidgets release primarily improves on the behavior of the dockable panel capability that is integral to the Builder/Viewer application.

Elimination of 64-bit Itanium Distribution

(4.5.1)  A single distribution of ECCE is now used for all Linux platforms.  Previously 64-bit Itanium processor (ia64) based Linux platforms used a special distribution of ECCE separate from all other 32- and 64-bit platforms.  With the ECCE 4.5.1 release, the Itanium processor ia64 release has been eliminated.  Only the distribution of NWChem bundled with ECCE was different between the two Linux distributions available for ECCE 4.5.  The ECCE Linux distribution consists of 32-bit applications that run on 32- and 64-bit platforms.  This requires the installation and use of 32-bit compatibility libraries on some 64-bit systems that otherwise cannot run 32-bit applications.  Because of the system log warning messages that are issued from running a 32-bit version of NWChem on an ia64 workstation (see below release note on the Itanium distribution), it is recommended that users download and install a distribution of NWChem specifically built for that platform.

New Java Messaging Server Implementation

(4.5) The previous JORAM server implementing the Java Messaging Service has been changed out in favor of the Apache supported ActiveMQ server in ECCE 4.5.  The most important reason for making this change was eliminating a pervasive problem experienced by many sites where the client side messaging session disconnected from the messaging server.  Often that would happen when leaving an ECCE session running idle such as overnight and then returning to use it the next day.  At that point any running ECCE applications would no longer function properly and it was not possible to start new applications.  A slew of Java “out of bounds” error messages to the console where the session was started also accompanied this problem.  The only workaround was to quit out of each ECCE application separately and restart the session.  The new ActiveMQ server (http://activemq.apache.org) has become a more widely used JMS implementation than JORAM over the many years since ECCE adopted JMS for inter-process communication (ActiveMQ did not exist when ECCE first selected a JMS implementation).  Configuring ActiveMQ is also a bit simpler than JORAM with only a single client side configuration file (jndi.properties) and a single server side configuration file (activemq.xml).  The ECCE distribution installation script makes the necessary updates for these two files and site administrators normally do not need to be aware of these details.  You will notice that the console output from starting the ActiveMQ server is different than from JORAM, but it is really only necessary to scan this output for errors, usually in the form of Java tracebacks.  Another advantage with ActiveMQ is that only one socket port is used for messaging rather than the three ports needed for JORAM.  By default ECCE uses the port 8088 for ActiveMQ, which was also one of the three used for JORAM.  The installation and administration manual describes how to change this port if needed.  Finally, the server “upgrade” option available from the installation script main menu does support upgrading what was previously a JORAM messaging server to become an ActiveMQ server so the changeover to the new JMS implementation should be transparent to both the ECCE site administrator and users.
WHAT’S FIXED

Builder Display Style Preference

(4.5.1)  A bug in the initial Builder port to wxWidgets for ECCE 4.5 kept the user’s preferred display style (Ball & Wire, Ball & Stick, etc.) from being remembered between invocations.  The display style would come up as “Ball & Wire” regardless of what it was set to when the Builder was last run.  The last set display style is now correctly saved as the user preference and restored as the current display style for subsequent Builder invocations.
SITE ADMINISTRATOR WHAT’S FIXED

Crashes Saving Thumbnails and Image Files from the Builder and Viewer
(5.0.1)  Certain operating systems and OpenGL hardware graphics drivers do not support the OpenGL off-screen rendering feature required by ECCE to save image files (JPEG, GIF, TIFF) and the thumbnail visualizations of chemical systems that are shown for the icon to access the Builder for a calculation.  Typically the X Window session will completely crash trying to use these ECCE features when off-screen rendering is not supported; returning the user to the Linux login screen.  Thumbnail visualizations are created by default when saving a chemical system in the Builder so it will appear as if a “save” operation is causing the crash.  The $ECCE_NO_VIZIMAGES environment variable has been created to keep ECCE from creating any image files including thumbnail visualizations.  Search for “ECCE_NO_VIZIMAGES” in the $ECCE_HOME/siteconfig/site_runtime file to override the default setting where off-screen rendering is used.  Without off-screen rendering the POV-Ray format for capturing images of visualizations can still be used.  Since POV-Ray produces publication/presentation high quality graphics and there are utilities to translate POV-Ray files to image formats like JPEG, the lack of off-screen rendering is an inconvenience rather than a loss of functionality.
Machine Registration Queued Machine Support
(5.0.1)  Several bugs were fixed with the Machine Registration application’s support for registering batch queued machines.  Because of the severity of these bugs, it was not previously possible to use the GUI application to register anything other than workstation class machines.  Now the Machine Registration application (accessible via “ecce –admin” for users with write permission to the $ECCE_HOME/siteconfig directory) can be used for registering both workstations and batch queued compute resources to ECCE.
WHAT’S BROKEN

